O{‘g‘h /4))0
N ( A\ Federal Aviation

S . . .
$ Administration

55054003

EN ROUTE

RADAR ASSOCIATE
CONTROLLER TRAINING PART C:
ADVANCED CONCEPTS

Lesson 3: Introduction to En Route
Decision Support Tool (EDST) Part 2

Version: 1.0 2022.08



PAGE INTENTIONALLY LEFT BLANK



LESSON PLAN DATA SHEET

Course Name

En Route Radar Associate Controller Training Part C: Advanced Concepts

Course Number

55054003

Lesson Title Review of En Route Decision Support Tool Part 2

Duration 2 hours 45 minutes (includes lesson, ELT, and part-task exercise)

Version 1.0 2022.08

Reference(s) T16110.101, En Route Automation Modernization RA-Position User Manual;

T16110.108, ERAM Quick Reference Controller Card; ERAM ATCHI MISC
230.05, ERAM SRS Air Traffic Computer-Human Interface; ERAM
CONFLICT AD 220.03, ERAM Conflict Management, Off-Line Problem
Determination, and Utility Algorithms; ERAM ADAPT AD 220.04, ERAM
Adaptation Algorithms

Prerequisites

NONE

Handout(s)

® Part-Task Exercise:
® TI16110.108, ERAM Quick Reference Controller Card

Exercise / Activity

Refer to handout for:
® Part-Task Exercise: Review of En Route Decision Support Tool Part 2

Run scenario 55054003 _L03_S## in the TTL

®
® YES - Written
®

Assessments
Materials and Pen and/or pencil
Equipment
Other Pertinent © Ensure lesson materials are downloaded to the classroom
Information computer
® Appendix A - TABLE 13-1-1, Clearance Abbreviations
© Appendix B - TABLE 13-1-2, Miscellaneous Abbreviations
© Appendix C - TABLE 13-1-3, EDST Equivalents for Control Information
Symbols
© Appendix D - Select Manual Strip Marking with EDST Equivalents
®© This lesson is based on ERAM EAE410

® The lesson has been reviewed and reflects current orders and manuals
as of April 2022
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LESSON ICON LEGEND

The Activity icon indicates an exercise, lab, or hands-on activity.

The Discussion Question icon signals a discussion question to be asked to the students.

The Handout icon indicates a handout is to be distributed to the students.

The Instructor Note icon is in hidden text and indicates text that is for the instructor only.

The Multimedia icon indicates a video or audio clip is in the presentation.

The Phraseology icon indicates that phraseology is in the content.

The WBT icon indicates a component of web-based training.

The Click icon indicates a PPT slide with click-based functionality to present additional
information.
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The Definition icon indicates a published definition.
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LESSON INTRODUCTION

Overview

En Route - Radar Associate
Controller Training Part C:
Advanced Concepts

Lesson 3: Introduction to En Route
Decision Support Tool, Part 2

Course - 55054003
Version=-1.0 2022.08

En Route Decision Support Tool (EDST) is the interface at the Radar
Associate (RA) position. Sector teams use EDST in performing their strategic
planning responsibilities.

In Lesson 2, Introduction to EDST Part 1, you learned how this tool derives
expected aircraft trajectories to predict conflicts.

This lesson will cover the Tools Menu and how to manage airspace, airport
stream filters, and restrictions. In addition you will learn about NOTAM, Gl,
and SIGMET views, the Wind Grid, the Graphic Plan Display, and free form
text.
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LESSON INTRODUCTION (conT'D)

Lesson
Objectives

Lesson Objectives

At the end of this lesson, you will be able to
identify:
+ Features of the Tools Menu

+ Steps to interact with NOTAMs, Gls, and
SIGMETs views

+ Weather and altimeter displays of EDST
+ Functions of the Graphic Plan Display
« EDST free form text

=]

doufe Dedsian Suppart Taol, Part 2

®© At the end of this lesson, you be able to identify:

Features of the Tools Menu

Steps to interact with NOTAMSs, Gls, and SIGMETs views
Weather and altimeter displays of EDST

Functions of the Graphic Plan Display (GPD)

EDST free form text

NOTE: There will be a graded end-of-lesson test upon completion of the
lesson. The passing score is 70%. If you do not achieve a score of 70%, you
will be provided study time and one retake of an alternate end-of-lesson test.
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TOOLS MENU

Options Menu

TI6110.101, Options Menu
sec. 4.21.3

ERAM ATCHI
MISC 230.05,
par. 3.7.17.6

Mot i

DERKSER
L JRCHA . UL . LML L R

ube Decisian Support Tod, Part 2

® Tools... button on the ACL menu bar is used to open the Tools Menu
® The Tools Menu is opened via:

* TBP Tools...>Options...
® Options Menu has four selection boxes:

* Display Coordination Column
— TBP to display the coordination column in the ACL
* Drop Track Delete

— TBP to specify whether dropped tracks are to be deleted
immediately from the ACL vs. the default mode of timing out from
the ACL

Continued on next page
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TOOLS MENU (conTD)

Options Menu
(Cont’d)

T16110.101,
sec. 4.21.3

JO 7110.65, par.

13-1-9

ERAM ATCHI
MISC 230.05,
par. 3.8.46

IAFDOF Manual

TBP to change automatic IAFDOF indication to manual mode

In manual mode you apply or remove the two states of IAFDOF
coding indicated by yellow and muted yellow colors

EDST Inappropriate Altitude for Direction of Flight (IAFDOF)
feature must be used in the automatic mode (i.e., IAFDOF Manual
must remain deselected) unless otherwise authorized in a facility
directive

Non-RVSM Indicator

When your sector does not contain RVSM altitudes, you have the
option to display the non-RVSM indicator on the ACL for flights
expected to enter RVSM airspace

The non-RVSM indicator is a coral box displayed to the right of
the altitude field when a flight is not equipped for RVSM flight and
the FP assigned altitude, interim altitude, or reported altitude
(Mode C or pilot reported) is at or above FL290

TBP the Non-RVSM Indicator box to display non-RVSM coding on
the ACL and GPD

If your sector contains RVSM altitudes, this menu item will be
grayed out
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TOOLS MENU (conT'D)

Airspace
Status View

Airspace Status View

B FACTLETY-WIDE | FACILTTIES ATASPACE STATLG - FXPAMET

T16110.101,
sec. 4.21.1

Lesgon 3 inroduction o En Route Decision Support Tod, Part 2

® The Airspace Status View is opened via:

 TBP Tools...>Airspace Status

* This view allows you to see the current and planned use of Special
Activity Airspace (SAAs)

® Designated RA positions may have the capability to:

* Change the status of SAAs
* Modify the schedules of SAAs
* Change the altitude limits of SAAs
® You may filter the display between SAAs that are of operational interest
to the sector position and all the SAAs in the local facility
* You may also be able to display SAAs of adjacent facilities

NOTE: The Airspace Status View will be covered in detail in a future
lesson.
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TOOLS MENU (conT'D)

Airport
Stream Filter

Status Airport Stream Filter Status
Display

T16110.101,
sec. 4.21.2

ERAM ADAPT
AD 220.04,
par. 2.7.1.2.2.1

Roule Dedsian Suppot Tad, Parit 2

gaon 3 Introduction o En

AIRPORT STREAM FILTERS (ASF) - An on/off filter that allows the
conflict notification function to be inhibited for aircraft-to-aircraft alerts
approaching an adapted set of destination airport(s) or departing an
adapted set of departure airport(s) to prevent nuisance alerts.

NOTE: Airport stream filters might not be adapted at your facility and/or
sector position. If the ASF for a sector position is on, aircraft-to-aircraft
alerts for the specified aircraft are inhibited when the initial points of
violation are within airspace assigned to the sector position.

® The Airport Stream Filter Status Display is opened via:

* TBP Tools...>Airport Stream Filter Status...

NOTE: Conflict probe can produce nuisance alerts at sectors with heavy
arrival and/or departure traffic.

Continued on next page
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TOOLS MENU (conT'D)

Airport ®© Airport stream filter status display columns:

Stream Filter

Status » Status

Display — Changes the status from on to off

(Cont’d) « Sector

T16110.101, — Displays sector number servicing the airport(s)
sec. 4.21.2 .« T

ERAM ATCHI — Displays “A” for arrival or “D” for departure
MISC 230.05, e Airport

par. 3.7.2 irport(s)

— Displays unique description for each filter
© Airport stream filter status display buttons:
* Filter
— Shows facility-wide ASF status
* Exit
— Removes the filter display
® To apply the filter to a specific airport:
e TBP “On” radio button

— All aircraft-to-aircraft alerts between flights meeting the criteria are
suppressed
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TOOLS MENU (conT'D)

Restrictions

View . . .
Restrictions View

T16110.101,

sec.4.21.4

ERAM ATCHI [AIFACILLTY -HIDE

MISC 230.05,

par. 19 -

Roule Dedsian Suppot Tad, Parit 2

® The Restrictions View:
* Is opened via:
— TBP Flight ID
— TBP Tools...>Restrictions

* Provides altitude and speed restrictions to model the trajectory based
on Letters of Agreement (LOAs) and Standard Operating Procedures
(SOPs)

* Allows you to turn restrictions on/off or revert to the prior setting on
the restrictions

— If FACILITY-WIDE is displayed
o View contains all of the restrictions that apply to the facility
— If SECTOR (sector ID) is displayed

o View contains only those restrictions for the sector

Continued on next page
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TOOLS MENU (conT'D)

Restrictions @® If you cannot change the status of a restriction, its radio buttons are gray
View (Cont’d) . .
The view has eight columns:
T16110.101,
sec. 4.21.4 * ON
ERAM ATCHI — Restrictions are always on (overriding the scheduled restrictions)
MISC 230.05, * OFF
par. 19

— Restrictions off (overriding the scheduled restrictions)
SCH

— Time restrictions turn on and off based on adaptation
STATUS

— Current status of the restriction
o ON (active)
o OFF (not active)
NAME
— Name of the restriction in adaptation
START END
— Times the restrictions are scheduled to be on or active

o A restriction can be scheduled to be active for two separate
time periods

— START indicates the time if set to scheduled SCH

— END indicates the time restriction will no longer apply
A/D

— Indicates arrival and/or departure

AIRPORTS

— Displays the airports that are affected by the restriction
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TOOLS MENU (conT'D)

Current
Restrictions
Menu

T16110.101,
sec.4.21.4

ERAM ADAPT

AD 220.04, par.

271241

Current Restrictions Menu

KATL

86 _ZHES TR _NLT238_n_BHH 1300 ) 10 L1 ERTL

5, P RRH, IRTH

Roule Dedsian Suppot Tad, Parit 2

® The Current Restrictions Menu:

*  Opened via:
— TBP Flight ID
— TBP Tools...>Restrictions

* Provides altitude and speed restrictions modeled for a specific flight
— Allows you to turn restrictions on/off or revert to the prior setting

* The radio buttons operate in a similar fashion as the Restrictions
View except:

— Revert is unique to the Current Restrictions Menu

o When selected, the aircraft reverts back to the current
restriction display schedule
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TOOLS MENU (conT'D)

Knowledge
Check

Knowledge Check

What is displayed in the Current Restrictions
view?

A. Restrictions you have verbally placed on other sectors
B. Center-wide restrictions

C. Adapted restrictions for a specific flight

Route Decisian Suppart Taol, Par 2

qon 3 Introduction o En

Question: What is displayed in the Current Restrictions view?

FAA55054003-LP03 / V1.0 2022.08 Page 11



TOOLS MENU (conT'D)

Knowledge
Check

Knowledge Check

What is the purpose of Airport Stream Filters?

A. Suppresses aircraft-to-aircraft alerts for the specific
airport(s)

B. Filters the display to only show flights for a single
airport

C. Displays all entries following similar routes

Leggon 3 nfroduction to En Route Decision Suppaoit Taol, Part 2

Question: What is the purpose of Airport Stream Filters?
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TOOLS MENU (conT'D)

Knowledge
Check

Knowledge Check

Which view displays the status of active Special
Activity Airspace?

A. Flight Restrictions View
B. Special Activity Area View
C. Airspace Status View

Route Decisian Suppart Taol, Par 2

qon 3 Introduction o En

Question: Which view displays the status of active Special Activity

Airspace?
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TOOLS MENU (conT'D)

Knowledge
Check

Knowledge Check

What are the steps to set IAFDOF to manual?

A. TBP Settings=Altitude=lAFDOF Manual
B. TBP Tools...>0Options...>=|AFDOF Manual
C. TBP Plans...=IAFDOF Manual

Route Decisian Suppart Taol, Par 2

Lesgon 3 Inreduction o En

Question: What are the steps to set IAFDOF to manual?
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NOTAMS VIEW

NOTAMS
View

T16110.101,
secs. 2.2,4.5.1

NOTAMS View

» Select the NOT button

HOTANS ALL E

BOEUW 11008 UM 23 THRE DS
EOLGU 1178717 LEW WIHSDHE

® OUEL RS 08T UEL TUWER

® UEL 417001 UEL TOWER %

® The NOTAMS view is accessed through NOT button on the EDST toolbar

* Initially displayed at a default location

* Suppressed via the EDST NOT toolbar button
NOTE: Currently this function is not used and another method is used for
NOTAMs. Specific instruction will be given in a later lesson.

* The NOT button is facility adaptable and might not be displayed in the
toolbar
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GENERAL INFORMATION (Gl) MESSAGES VIEW

Gl Messages
View

T16110.101,
secs. 2.2,4.6.1

Gl Messages View
» Opened by TBP or TBE on the Gl button
» Time of new messages underlined

[ GEMERAL IHFORHATION HESSAGES DELETE| PRINT|—]

.| 12 31 92 33 51 52 53 o GROUHD DELAY PROGRAM FOR SF0 UMTIL 208597 DUE
™ CENLI THAA AT/ DA

U 1545 Gl © o SLCTORE T8 OFEM USE 128 6%

1540 GT © o SECTOR 3 IS QFEH
k7

= 1533 BT € o CHECE GUARD FREOS

n Route Deois it Taol, Part 2

Toolbar Gl button yellow text and number indicate new General
Information (GI) message(s)

General Information Messages view is opened by TBP or TBE on the Gl
button
* The view will be displayed at:

— The previous location, or

— The default location if the Gl Messages view has not been
displayed previously
A new Gl message is indicated by an underline of the time the Gl was
sent

A new Gl message may be acknowledged by TBP or TBE on the time Gl
was sent

* New message coding for that message is removed

* When all new Gl messages have been acknowledged:

— A white check mark “v” replaces the number in the toolbar Gl
button

— Gl button text changes from yellow to white
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Gl MESSAGES VIEW (coNnT'D)

Forwarding Gl

Messages Forwarding Gl Messages

T16110.101,
sec. 4.6.2.1

M B - E ATITLE AT o4 g1 | WOH AT | P

FOLC | OPDLC | EEEF 5 = L)
ALST (| PEGIRIT | ALl AR | DO | HALT

HE <0G
REORT

GEHLRAL THIORMAT IOH HESSAGLES

® Gl messages may be forwarded to internal facility areas, sectors, and AT
Specialist positions which have not previously received the message

® To forward a Gl message:

* TBP on the message to be forwarded
*  When pop-up menu appears, TBP or TBE FORWARD

* When SELECT SECTOR pop-up appears, TBP all but last sector,
area, or AT Specialist position

* TBE the last sector, area, or AT Specialist position

— If the Gl Message is being forwarded to a single position, TBE
that position to forward the message
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Gl MESSAGES VIEW (coNnT'D)

Deleting
Single GI
Message

T16110.101,
sec.4.6.3.4

Deleting a Single Gl Message
« TBP or TBE click entry, then...

Hx 10 HOT 61« ¥ (g i
T ALST | e i

1618 1 92 31 32 33 51 52 53 0 GROUMD DELAY PROGRAM FOR SFO UNTIL 20592 DUE
TO LDOW CEIL THAG1ET B DR

L1585 E1 C o SECTOR 18 OPEM USE 124.65
L1588 EI C o SECTOR 3 15 OPEH
._.-'l 1533 GI C & CHECE GUARD FREDS

CTOR TH DI'EH 0%l 12% &%
ETOR 3 1% OPEH

z OUND DELAY PROGRAM FOR EWR UNMTIL Z158Z DUE To LOW
H TH1E1435/D8

Leggon 3 nfroduction to En Route Decision Suppaoit Taol, Part 2

® To delete a single message:

 TBP or TBE entry to be deleted
*  When pop-up menu appears TBP or TBE DELETE

NOTE: Deleting a GI Message removes the message from display at your
sector only.
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Gl MESSAGES VIEW (coNnT'D)

Deleting
Multiple GI

Messages Deleting Multiple Gl Messages

T16110.101,
sec.4.6.3.4

T WL STRTLE UG T

L | T ciny i | BOH- | SAT -
(LT || PG | T
GERERAL [MFORMATIOM HESSAGES PEIHT |~

WAN GI 12 31 32 33 51 52 53 0 GROUMD DELAY PROCARH FOR SFOUNTIL 20592 D
5 T LDW CETLEMES .. THAS1618/80

e
B —b‘ 1545 GI € o TECTOR 18 OPEN USE 124 .65

TBE q 15%0 GI € o SECTOR 3 IT OPEM
' P GI C o GROUND DELAY PROGRAM FOR ENR UNTIL 21907 DUE T LOW
THTET %55 /D

Resuliing Gl M

W[ GEWERAL TRFORHATION WESSAGES  [BFLETE[FRINT]-]

THTH GBI 17 07 32 03 %1 52 50 & GABUHD LAY PFROGEAH FER SF0 UNTIL 20592 DU

AV PROGRAM FOR EMR UNTIL 20502 DUE TO LOW

Roule Dedsian Suppot Tad, Parit 2

® To delete multiple messages:

e TBP or TBE DELETE in the view header
* TBP on all entries to be deleted except the last entry
e TBE the last entry to be deleted
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Gl MESSAGES VIEW (coNnT'D)

Knowledge
Check

Knowledge Check

How are new Gl Messages indicated on the GI
button in the toolbar?

<1 I
Easvd o °

A, Yellow text and check mark
B. Yellow text and asterisk
C. Yellow text and number

Roule Dedsian Suppot Tad, Parit 2

Lesgon 3 Inreduction o En

Question: How are new Gl Messages indicated on the Gl button in the
toolbar?
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Gl MESSAGES VIEW (coNnT'D)

Knowledge
Check

Knowledge Check

How can you delete multiple Gl messages at one
time?

A. TBP or TBE each GI>TBE DELETE in the header

B. TBP or TBE DELETE in the header>=TBP each Gl but
the last>TBE the final GI

C. TBH or TBE SELECT in header>TBE on each
GI=TBE on final Gl

Route Decisian Suppart Taol, Par 2

Lesgon 3 Inreduction o En

Question: How can you delete multiple Gl messages at one time?
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SIGMETS VIEW

SIGMETS

View SIGMETS View

T16110.101,
secs.4.41,
4434,44.38

Leggon 3 nfroduction to En Route Decision Suppaoit Taol, Part 2

® Toolbar SIG button yellow text and number indicate new message(s)
®© SIGMETS view is opened by TBP or TBE on the toolbar SIG button

* The view will be displayed at:
— The previous location, or

— The default location, if the SIGMETS view has not been displayed
previously

© SIGMETS view entries include messages as follows:

* SIGMETs (SIGMET/WS)

* Convective SIGMETs (SIGMET/WST)

* Airmen’s Meteorological Information (AIRMET/WA)
* Center Weather Advisories (CWA)

* Urgent Pilot Weather Reports (Urgent PIREP/UUA)
* Meteorological Impact Statements (MIS)

Continued on next page
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SIGMETS VIEW (conT'D)

SIGMETS * A new SIGMET message is indicated by an underline of the time the
View (Cont’d) message was sent

TI6110.101, * A new SIGMET message may be acknowledged by TBP or TBE on
secs. 4.4.3.4, the time the message was sent

4.4.3.5,44.3.8,

— Newm ing is remov
4.4.3.9 ew message coding is removed

— When all new messages have been acknowledged:

o A white check mark “v” replaces the number in the toolbar
SIG button

o SIG button text changes from yellow to white
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SIGMETS VIEW (conT'D)

SIGMETS
View -

Suppress/ SIGMETS View- Suppress/Restore

Restore

T16110.101,
secs. 4.4.3.4,
4435,44.37,
4.4.3.8,4.4.3.9

Leggon 3 nfroduction to En Route Decision Suppaoit Taol, Part 2

® SIGMETs cannot be removed, only suppressed
® Suppressing a SIGMET

* Use TBP or TBE to select a SIGMET
— Two pop-up pick areas appear: SUPPRESS and PRINT
* TBP SUPPRESS
® SIGMET entry is moved to suppressed area
* The suppressed area is above the unsuppressed area and a gray line
separates the areas

* Dependent upon user setting, suppressed entries may be in view or
hidden

Continued on next page
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SIGMETS VIEW (conT'D)

SIGMETS ® Restore a suppressed SIGMET

View-

Suppress/ e |f the VIEW SUPPRESS not activated

Restore — TBP or TBE the “M” in the view header

(Cont'd) o TBP or TBE VIEW SUPPRESS, all suppressed entries now
T16110.101, appear above the gray line

secs. 4.4.3.4, — TBP or TBE the desired SIGMET

4.4.3.5,4.4.3.8, o Two pop-up pick areas appear: RESTORE and PRINT
4439

TBP or TBE RESTORE

o SIGMET entry is restored to the Unsuppressed SIGMET Entry
Area
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PRINTING - NOTAMS, GENERAL INFORMATION
MESSAGES, AND SIGMETS

Printing -
NOTAMs, Gl Printing - NOTAMs, Gl Messages, and

Messages, SIGMETs
and SIGMETs ———

T16110.101,
secs. 4.4.3.5,
4537,46.3.6

M 3| s | oo | wanr

HLLTE|FEIST| =

Legson & Introduction b0 En Route Dedsion Support Tod, Part 2

® You may print from all three views using the following options:

* Print a single entry
*  Print multiple entries
¢ Print all entries
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PRINTING - NOTAMS, GENERAL INFORMATION
MESSAGES, AND SIGMETS (conT'D)

Printing a

Single Ent . . -
noeET Printing a Single Entry
T16110.101,
sec. 4.5.3.7

HOTAHS ALL ENTRIES LOCATION 1D

! CEC BS/BuE ThHU RWY LLCTS PCL KEY 127.8

! OEUW 11,5005 EUM 23 THR DEPLCD SO0 1500-235% DLY

f LGN 11781 LGU UORSBME DTS WEF @711

! UEL B9/S@01 VEL TOWER S416 (333 AGL) LTS 0TS

! UEL 117801 UVEL TOWERE S6146 (200 AGL) 16 LETS @15

TBF or TBE PRINT - prints
entry on a Flight Strip

g50n 3 nroduction o En Rowe Dedsion Suppart Tad, Part 2

® To print a single entry:
 TBP or TBE on entry

e Within entry pop-up, TBP or TBE PRINT

— Entry will print on a flight strip printer
NOTE: All entries are eligible for printing, including suppressed entries.

FAA55054003-LP03 / V1.0 2022.08 Page 27



PRINTING - NOTAMS, GENERAL INFORMATION
MESSAGES, AND SIGMETS (conT'D)

Printing

Entrive. Printing Multiple Entries

T16110.101,
sec. 4.4.3.5 o [ on] G W [sie [ |

FILC | OFILC | FEEF THTURUTIGE | oy
EST | PGt | Al actrer| ee |4 AL pnen | comn | wAar

|'I|'|II1 H B 3 %1 52 53 o CEUMD DELAY PHOCHAM FOR 5F0 UHTIL 2892 D
|”I LOW CEILT ST 6T B0

1545 61 C o SECTOR 18 DPEM USE 1Z2&.0%

Legson & Introduction b0 En Route Dedsion Support Tod, Part 2

® To print multiple entries:

e TBP or TBE PRINT button in title bar
* TBP all entries, except last entry, to be printed
* TBE last entry to be printed
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PRINTING - NOTAMS, GENERAL INFORMATION
MESSAGES, AND SIGMETS (conT'D)

Printing All
Entries

Printing All Entries

T16110.101,
sec.4.4.3.5

+ Al entries will print after TBE on PRINT ALL button

_ HiDE TUFPRESS

EOH &3 M LOZ-EnU-1688 PIE-{138S5E LCH-AEEE
REF Wl #TF A%, FRINT ALL

EL SICHET UHIFORM ¥. COHDS HAUE DASHD.

s 5 Kl SIGHET UHIFORH 1 DALIE URTEL T6%% G0 HH FREH
CHE TD AKD TO 3I@SE THE TO IMHE T@ ELF TO ZBE 550 T@ JHC TO CHE DCHL TEU TURE ELD
‘:“ 168 BUE TD STE HAY WHBS OUR AUFF TREH. STG UDDFS LHLY SE OF RDELHS BY 15157.
DER
I

g50n 3 nroduction o En Rowe Dedsion Suppart Tad, Part 2

® To print all entries:

* TBP or TBE the “M” pick area in the view header
e TBP or TBE PRINT ALL button
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PRINTING - NOTAMS, GENERAL INFORMATION
MESSAGES, AND SIGMETS (conT'D)

Knowledge
Check

Knowledge Check

When printing more than one Gl message,
on all except on the last entry.

A. TBP; TBE
B. TBPF; TBP

C. TBE; TBE

Question: When printing more than one Gl message, on all except
on the last entry.
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WEATHER AND ALTIMETER DISPLAYS

Weather
Station

Report View Weather Station Report View

TI6110.101,
sec. 4.3

Menu - - .
Pick — ™ ﬂ\-\, A\
oy A3 ‘ o

Area

T 85H SCTe47

Legson & Infroduction @ En Roule Dedsian Suppa Taol, Part 2

® The Weather Station Report View provides weather station reported
information

* The view is opened via the WX REPORT button on the EDST toolbar
© Add weather station with keyboard command

* WR (station ID) KBE
— The entry of a typed station ID acts as a toggle
o If the station ID is not in the list, the report is added

o If the station ID matches an existing station ID, the report is
deleted

®© A single weather reporting station can be added to or deleted via the WX
pop-up input box

e TBP or TBE “M” in the header
— The view menu appears

Continued on next page
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WEATHER AND ALTIMETER DISPLAYS (CONT'D)

Weather
Station * Type a weather station ID and press the Enter key
?gp"tftd;"ew —  If the station ID is not in the list, it will be added
on
— If the station ID matches an existing station ID it will be deleted

T16110.101, — If the station ID syntax is not valid, the input box remains
sec. 4.3 displayed and an INVALID indicator is displayed below box

o The box remains open for you to edit the station ID and

resubmit

— The entry of a typed station ID acts as a toggle
© Deleting a station with the trackball

* Place the cursor over the station to be deleted
— Station has dwell emphasis
e TBPorTBE
— Station is highlighted
— DELETE pop-up appears
e TBP or TBE the DELETE pop-up
— Station is deleted
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WEATHER AND ALTIMETER DISPLAYS (CONT'D)

Altimeter
Settings View

TI16110.101,
sec. 4.8

T16110.108, AT
p. 4 View Title Pick

ERAM ATCHI , | e
MISC 230.05 r'°'1%""l-1 M[ ALTIM SET |-y Minimize
par. 6.8.1 Pick BHI View Pick

Area RIC Area

Altimeter Settings View

OEF

1

|
ROR |

1
EKN 1+

455

VEH 1455

Lesgon 3 inroduction o En Route Decision Support Tod, Part 2

®© The Altimeter Settings View provides altimeter station(s) name, time, and
setting
* The view is opened via the ALTIM SET button on the EDST toolbar

© Station Identifier - The two to five letter identifier of the station where the
observation was taken

© Altimeter setting

* The altimeter setting is underlined if it is below 29.92
* |f the station report is missing, an “-M-" will be displayed
© Add altimeter station using the keyboard

* AR (station ID up to 4) KBE

— The entry of a typed station ID acts as a toggle
o If the station ID is not in the list, it will be added

o If the station ID matches an existing station ID it will be
deleted

Syntax: AR <LOC ID> (LOC ID) (LOC ID) (LOC ID)

Continued on next page
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WEATHER AND ALTIMETER DISPLAYS (CONT'D)

Altimeter O]
Settings View
(Cont’d)

T16110.101,
sec. 4.8, 4.8.1

ERAM ATCHI
MISC 230.05,
par. 6.8.1

Add altimeter station using the menu

TBP or TBE “M” in the header

— The view menu appears

TBP or TBE TEMPLATE

— The template appears and replaces the view menu
— The template contains 24 cells

TBP or TBE template cell to type in

— The cell has selection emphasis

Type the altimeter station name

— Selection emphasis is removed

— Typed characters are echoed in the template cell
Press the enter key

— Altimeter Station name is submitted for system processing
There are three possible outcomes:

— The altimeter setting is added to the view
— INVALID

o If command processing fails the syntax check
— NOT FOUND

o If command processing passes the syntax check but the
station name is not found in adaptation

Continued on next page
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WEATHER AND ALTIMETER DISPLAYS (CONT'D)

Altimeter
Settings View
(Cont’d)

T16110.101,
sec. 4.8, 4.8.1

ERAM ATCHI
MISC 230.05,
par. 6.8.1

* Close the template

— Station ID(s) and the layout in the template are reflected in the
Altimeter Settings View

© Deleting a station with the trackball

* Place the cursor over the station to be deleted
— Station has dwell emphasis

* TBPorTBE
— Station is highlighted
— DELETE pop-up appears

* TBP or TBE the DELETE pop-up
— Station is deleted

® The following information is provided for each altimeter station entry:

¢ Observation time is underlined when it is more than 65 minutes old
* Setting is underlined if it is below 29.92
* “-M-"is displayed if the report is missing
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WEATHER AND ALTIMETER DISPLAYS (CONT'D)

Knowledge
Check

Knowledge Check

What will happen if you enter WR DCA on the

keyboard and the WX view already contains the
DCA report?

A. You will receive an error message

B. DCA report will update to the most current weather
report

C. DCA report will be deleted from the view

| Leggon 3 nfroduction to En Route Decision Suppaoit Taol, Part 2

Question: What will happen if you enter WR DCA on the keyboard and the
WX view already contains the DCA report?
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WEATHER AND ALTIMETER DISPLAYS (CONT'D)

Knowledge
Check

Knowledge Check

How do you access the template for the ALTIM
SET view?

A. TBP or TBE "M" in the header
B. TBP or TBE Tools>Template
C. TBP or TBE ALTIM SET on the view

Route Decisian Suppart Taol, Par 2

Lesgon 3 Inreduction o En

Question: How do you access the template for the ALTIM SET view?
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WEATHER AND ALTIMETER DISPLAYS (CONT'D)

Knowledge
Check

Knowledge Check

You attempt to enter an altimeter station into the
ALTIM SET template and you get an invalid
response. What does this mean?

A. The altimeter setting is missing
B. The altimeter is more than one hour old

C. The station ID entered is incorrect

Lesgon 3 nreduction o En Route

Dieci=ion Suppolt Taol, Part 2

Question: You attempt to enter an altimeter station into the ALTIM SET
template and you get an invalid response. What does this mean?
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WEATHER AND ALTIMETER DISPLAYS (CONT'D)

Knowledge
Check

Knowledge Check

How do you remove a weather report with the
trackball?

A, TBP or TBE DELETE in the header=TBF or TBE the
report

B. TBP or TBE the report=TBP or TBE DELETE
C. TBP or TBE "M" in the header=TBP or TBE the report

Route Decisian Suppart Taol, Par 2

Lesgon 3 Inreduction o En

Question: How do you remove a weather report with the trackball?
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WIND GRID

Wind Grid
Layout and
Function

T16110.101,
sec. 3.3

Wind Grid - Layout and Function

Lesgon & inroduction 0 En Route Dec<ion Support Tod, Part 2

® The Wind Grid Display contains wind and temperature data

The view is opened via the WIND button on the EDST toolbar

Date and time of the National Weather Service prediction for the
specified altitude level is in the menu bar area

Wind and temperature data is overlaid on a map of the center sectors
— Arrows depict wind direction
o Longer arrows depict stronger speeds
— Speed is shown in knots
— Temperature is displayed in degrees Celsius
Keyboard commands
- UUWwW
o Forces wind display at default or last displayed altitude
- UU W <altitude>
o Forces wind display at a specified altitude

Continued on next page
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WIND GRID (conT'D)

Wind Grid *  When the Show Temp button is visible, winds are displayed

tzﬁz;‘;iﬂd — TBP to toggle between wind and temperature data

(Cont'd) . When the Remove Temp button is visible, temperatures are
displayed

T16110.101,

sec. 3.3.3.5
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WIND GRID (conT'D)

Wind Grid -
R t . .

eoenter Wind Grid - Recenter
T16110.101,

sec. 3.3.3.3 [« Begin with TBP

® To recenter the map:

* TBP on the Recenter button
* TBP over the desired map center point
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WIND GRID (conT'D)

Wind Grid -
Change

Range Wind Grid - Change Range

T16110.101,
sec. 3.3.3.4

® The current Wind Grid range value is displayed in the Range button
* Asingle TBE will increase the range by 25 miles
* Asingle TBP will decrease the range by 25 miles

* If you try to adjust the range lower than the lowest setting or higher
than the highest setting, an alarm tone will sound
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WIND GRID (conT'D)

Wind Grid -
Change

Display Wind Grid - Change Altitude

Altitude

T16110.101,
sec. 3.3.3.6

Lesgon 3 inroduction o En Route Decision Support Tod, Part 2

® The Wind Grid is initially displayed at the default altitude of 29,000’
® The displayed altitude can be changed to any value from zero to 59,000’
® To change the altitude displaying wind or temperature values

 TBP on the Altitude button

— The Altitude Menu is opened
e TBP on the desired altitude in the Altitude Menu

— Desired altitude data is displayed
® To exit the Altitude Menu

* TBP the EXIT button
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WIND GRID (conT'D)

Wind Grid -
Problem

Indicators Wind Grid - Problem Indicators

T16110.101,
secs. 3.3.1.2,
3.3.1.3

Stale Weather indicator

Mo'Weather Data

Lesgon 3 inroduction o En Route Decision Support Tod, Part 2

® When weather data is unavailable for display:

* NO WEATHER DATA is displayed in yellow text across the display

© If the weather data available for display for the selected altitude is older
than the hour for which it was forecast

* Time indicator is displayed in yellow indicating stale weather data
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WIND GRID (conT'D)

Knowledge
Check

Knowledge Check

What is the keyboard command to show the
wind grid display at a specified altitude?

A. UU <altitude= W
B. UU <altitude>
C. UU W <altitude>

Route Decisian Suppart Taol, Par 2

Lesgon 3 Inreduction o En

Question: What is the keyboard command to show the wind grid display at a
specified altitude?
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WIND GRID (conT'D)

Knowledge
Check

Knowledge Check

After TBP on Recenter, how do you recenter the
map over an intersection?

A. TBP over intersection where you want the map
centered

B. TBE over intersection where you want the map
centered

C. TBH the intersection where you want the map
centered

Roule Dedsian Suppot Tad, Parit 2

Lesgon 3 Inreduction o En

Question: After TBP on Recenter, how do you recenter the map over an
intersection?
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WIND GRID (conT'D)

Knowledge
Check

Knowledge Check

How do you decrease the range by one 25 mile
increment?

A. TBE on Range button
TBP on Range button
C. TBH on Range button

Roule Dedsian Suppot Tad, Parit 2

Lesgon 3 Inreduction o En

Question: How do you decrease the range by one 25 mile increment?
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Graphic Plan Display

Opening the
GPD

T16110.101,
secs. 2.5.6,
3.1.1

Opening the GPD

iy loalbar Button

Leggon 3 infroduction o En Route Decision Suppoit Taol, Part 2

® Graphic Plan Display depicts Trial Plans, FPs, and surrounding traffic

® Access the GPD by using one of the following:

TBP or TBE GPD button in EDST toolbar

— Click again to close the GPD or use the Exit button in the GPD
TBE flight ID

— Click on a flight ID to open the GPD with the trajectory highlighted
— TBP or TBE Exit button to close the GPD

TBE an ACL Alert

— Click on any ACL alert to open the GPD with that conflict
highlighted

— TBP or TBE Exit button to close the GPD
Uu G

— Enter UU G in MCA to open the GPD
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GRAPHIC PLAN DISPLAY (coNnT'D)

GPD Title Bar
T16110.101,

sec. 3.1.1.1 GPD Title Bar

Leggon 3 infroduction to En Route Decision Suppaoit Taol, Part 2

© Title bar is at the top of the GPD and contains the following:

*  Window Menu button

* Display minimize and maximize or restore buttons

* Display Title

* The text Current Time or Future Time is displayed after the GPD title
— In the case of future time

o The number of minutes the GPD has been moved into the
future appears after Future Time label

o GPD border highlighted in white
Example: Graphic Plan Display - Future Time +2

Continued on next page
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GRAPHIC PLAN DISPLAY (coNnT'D)

GPD Menu
Bar - General

Tl 61;3.11021, GPD Menu Bar - General
sec. a.1.1.

Leggon 3 infroduction to En Route Decision Suppaoit Taol, Part 2

® Menu Bar buttons access options and menus for managing the GPD map
and flight display features

® Recenter button

* Used to recenter the map

— Function is similar to the Wind Grid Display
® Range button

* Used to change the scale of the GPD
* Asingle TBE will increase the range by 25 miles
* Asingle TBP will decrease the range by 25 miles

Continued on next page
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GRAPHIC PLAN DISPLAY (coNnT'D)

GPD Menu
Bar - General ® Suppress or Restore button
(Cont’d) .
* TBP to suppress the display of data blocks on the GPD that are not
T16110.101, displaying current or trial plan route data
sec. 3.1.1.2

* TBP to restore the display of data blocks
® Map Options... button

* TBP to open Map Options Menu
e TBP Map Features... pick area

— Displays the Map Features Menu

o TBP to select different map elements and associated labels
for display or removal

o Removing a map element will also remove its label; however,
the label may still be selected for display

NOTE: Labels are only viewable if the map features are selected
for display.

— Map Features Menu options
o Sector Boundaries

Center Boundaries

Approach Control Boundaries

Special Activities Airspace

Airways

O O O O

Continued on next page
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GRAPHIC PLAN DISPLAY (coNnT'D)

GPD Menu

Bar - General o Airports and Airport Labels

(Cont’d) o NAVAIDs and NAVAID Labels

T16110.101, o Waypoints and Waypoint Labels

sec. 3.1.1.2 o Scale - if selected, the scale indicator is located in the last line

of the menu bar area, on the left side.
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GRAPHIC PLAN DISPLAY (coNnT'D)

GPD Map
Symbols

T16110.101, GPD Map SymelS

sec. 3.1.1.3

SAA Labels

Leggon 3 infroduction to En Route Decision Suppaoit Taol, Part 2

® The GPD uses a set of map symbols that are typical of ATC radar or
Situation Displays

* Symbols include sector boundaries, center boundaries, airports, fixes,
approach control boundaries, airways, and intersections

* Labels can be displayed for fixes, intersections, airports, and Special
Activity Airspace (SAA)

* Special symbols used in the GPD include the following items:
— Sector Boundaries
o White line
— Center Boundaries
o Bold white line
— Approach Control Boundaries
o Gray dashed line
— Airports
o  White box

Continued on next page
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GRAPHIC PLAN DISPLAY (coNnT'D)

GPD Map
Symbols
(Cont’d)

T16110.101,

sec. 3.1.1.3

NAVAIDs
— VOR and VORTAC
o White circle
— TACAN
o White splat
Intersections, Waypoints
—  White plus
Victor airways
—  White line
Jet routes and Q routes
—  White line
Special Activity Airspace Boundaries
— Solid white line, cold
— Solid orange line when an airspace alert is displayed
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GRAPHIC PLAN DISPLAY (coNnT'D)

GPD Aircraft
Display Menu

TI6110.101, GPD Aircraft Display Menu

sec. 3.1.2.5

_ Graphic "Lan isples e
I v

® The AC Display Menu pick area is found in the Maps Options Menu
®© TBP AC Display Menu... pick area

* Aircraft Display Menu options:

— Aircraft List Filter

— Altitude Filter Limits

— Filter Above and Filter Below

— Auto Datablock Offset

— Route Preview
o TBP to show 1 minute route preview
o TBP to show 2 minute route preview
o TBP to show 3 minute route preview

Continued on next page
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GRAPHIC PLAN DISPLAY (coNnT'D)

GPD Aircraft

Display Menu o MSP and MEP Labels
(Cont’d) o TBP to suppress MSP label
T16110.101, o TBP to restore MSP label
sec. 3.1.2.5

MANEUVER START POINT (MSP) - Symbology (asterisk) displayed
on the projected route of flight to indicate when an altitude maneuver is
predicted to start. Also displays an Up or Down arrow to indicate the
direction of the maneuver.

MANEUVER END POINT (MEP) - Symbology (asterisk) displayed on
the projected route of flight to indicate when the altitude maneuver is
predicted to be completed.

NOTE: The maneuver start and end points are only predictions made by the
system based on computed trajectory and may not accurately predict what
the aircraft will fly.

® TBP Tools... button

* Displays the Tools Menu
e TBP Save GPD Map button

— Tools...>Save GPD Map pick area
o Saves current range and center of the GPD map

o Exiting the GPD without saving causes the map center and
range to be lost

® Saved Map button

* Used to display the most recently saved Graphic Plan Display range
and map center
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GRAPHIC PLAN DISPLAY (coNnT'D)

GPD Menu
Bar - Flight

Specific GPD Menu Bar - Flight Specific

T16110.101,
sec. 3.1.1.2

Leggon 3 infroduction to En Route Decision Suppaoit Taol, Part 2

© Flight specific Menu Bar buttons become active only when a flight ID is
selected

® Plan Options... button

* Displays the Plan Options Menu for the GPD
* TBP flight ID

— Plan Options..., Hold..., Show, Show All, Graphic... buttons
become active

* TBP Plan Options button to open that menu
* TBP Exit to close

Continued on next page
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GRAPHIC PLAN DISPLAY (coNnT'D)

GPD Menu
Bar, Flight
Specific
(Cont’d)

T16110.101,
sec. 3.1.1.2

® Hold... button

Displays the Hold Data Menu
TBP to open Hold Menu
TBP Exit to close

® Clean Up button

Used to remove projected route lines for current and trial plans as
well as alerts from the GPD

® Show... button

Used to graphically display or remove a selected aircraft’s current
plan and any specific alert assigned to the users sector

TBP alert

— Show button becomes active
TBP Show to display the alert
TBP Clean Up to clear

® Show All... button

Used to graphically display or remove a selected aircraft’s current
plan and all the alerts associated with the selected aircraft

TBP the flight ID

— Plan Options..., Hold..., Show, Show All, Graphic... buttons
become active

TBP Show All to display all alerts
TBP Clean Up to clear

Continued on next page
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GRAPHIC PLAN DISPLAY (coNnT'D)

GPD Menu
Bar, Flight
Specific
(Cont’d)

T16110.101,

sec. 3.1.1.2

® Graphic... button

Used to create graphical trial plans for route amendments
TBP the flight ID

— Plan Options..., Hold..., Show, Show All, Graphic... buttons
become active

TBP Graphic... to enter graphic mode
— Covered in future lesson

® Template... button

Opens the Flight Plan Template to create a FP if no entry is selected,
or

Opens the Amendment Template to amend a FP if an entry is
currently selected
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GRAPHIC PLAN DISPLAY (coNnT'D)

GPD Menu
Bar - Plan

Specific GPD Menu Bar - Plan Specific

T16110.101,
sec. 3.1.1.2

®© Due to Reason Chevron, AM+Uplink, Amend, and Interim buttons
become active once a specific trial plan or amendment plan is selected

Example: SAMOO1 has a trial plan for FL240.
© TBP the trial plan ID to activate the following Menu Bar buttons:

¢ Due to Reason Chevron

— Due to Reason buttons are messages that can be appended to
the uplink request

* AM+Uplink
— Used to send and uplink an amendment
*  Amend
* Interim
— Used to send an interim altitude message to the system based on
a Trial Plan
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GRAPHIC PLAN DISPLAY (coNnT'D)

GPD Main
Display Area,

Symbols GPD Main Display Area

T16110.101,
sec. 3.1.1.3

AAlL 994

Position Symbol o0 }"-.l | | ‘ ] 49

Flight Path

Lesgon 3 inroduction o En Route Decision Support Tod, Part 2

®© Each aircraft is represented by a position symbol and if selected, a
projected flight path

CAUTION: The GPD may resemble radar, but it is not radar. The GPD uses
coding techniques to draw your attention to a particular data block, FP, or
one of its components.

® White chevrons

* Used to mark the location of the beginning and end points of the
TFM-protected segment of a route

— Bisect the route line, pointing inward towards the protected
segment of the route

Continued on next page
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GRAPHIC PLAN DISPLAY (coNnT'D)

GPD Main

Display Area, ® Coral “A”

Route ,

Symbols * A Non-Automated Dependent Surveillance-Broadcast (ADS-B)

(Cont'd) indicator is displayed when the track indicates that there is no ADS-B,
and the NON-ADSB button in the Toolbar is selected
T16110.101,

sec. 3.1.1.3
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GRAPHIC PLAN DISPLAY (coNnT'D)

GPD Data

Block

T16110.101,
sec. 3.1.1

GPD Data Block

HKROR HG
__.l_|r|r--1 Flight Flan As

Altitude, or Time at

Lesgon 3 inroduction o En Route Decision Support Tod, Part 2

® The GPD data blocks look similar to full data blocks displayed on the R
Position Situation Display

® Data Block Lines

Line O - Alert Indicators

Line 1 - Aircraft ID

Line 2 - Altitude

Line 3 - Destination and Ground Speed

Line 4 - Flight Plan Assigned Altitude, Block Altitude, or Time at
Coordination Fix

Continued on next page
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GRAPHIC PLAN DISPLAY (coNnT'D)

GPD Data
Block Examples: UALO11 and UAL212, line 0, yellow alerts
(Cont’d)
SLAM31, line 4, climbing to a block altitude
T16110.101,
sec. 3.1.1 UAL215, Line 2 and line 4, interim altitude with assigned altitude
ERAM ATCHI UAL®®6, Line 0, not probed
MISC 230.05,
pars. 2.1.3, 3.6- UAL®O17, line 4, inadequate track data, time at coordination fix
36,114
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GRAPHIC PLAN DISPLAY (coNnT'D)

Using the
GPD Data

Block Using GPD Data Block

ERAM_ATCHI_
MISC_230.05,
par. 11.8.13

T16110.101,
secs. 3.1.2.7,
3.1.3.5.2

® Using the GPD data block

* TBP and hold the data block, leader line, or projected route line and
drag
— Moves the data block to a new location
— Release TBP to place the data block

* TBP on the altitude field in the data block
— The altitude field in the GPD data block is highlighted
— The Altitude Menu is displayed

Continued on next page
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GRAPHIC PLAN DISPLAY (coNnT'D)

Using the
GPD Data * TBP on the destination field in the data block
Block _ The destination field is highlighted
(Cont’d) o

— The Route Menu is displayed
ERAM_ATCHI_ * TBP on the speed field in the data block
MISC_230.05,
pars. 11.7.22.1, — The speed field is highlighted
11.7.23.1 — The Speed Menu is displayed
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GRAPHIC PLAN DISPLAY (coNnT'D)

GPD Future
Time Bar

T16110.101, GPD Future Time Bar
sec. 3.1.1.2

-I'.I"".I'I h |tE‘

Border

Lesgon 3 inroduction o En Route Decision Support Tod, Part 2

® The GPD Future Time bar scrolls time into the future
* This allows you to look at and evaluate the graphical situation up to
20 minutes out
* Use the trackball to select a future time in any of the following ways:

— TBP and hold on the slider and move it across the bar and
release at the desired time increment

— TBP anywhere on the Future Time bar to move the slider towards
the cursor in one-minute increments

— TBE anywhere on the Future Time bar and the slider will
automatically move to that time increment

Continued on next page
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GRAPHIC PLAN DISPLAY (coNnT'D)

GPD Future

Time Bar ® When the Future Time bar is used to display projected GPD data at a
(Cont’d) specified time in the future, the white border around the entire GPD
T16110.101, becomes a wider whiter border

sec. 3.1.1.2 ® Alert coding is not impacted by future time display
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GRAPHIC PLAN DISPLAY (coNnT'D)

Knowledge
Check

Knowledge Check

How can you determine if a GPD track has no
ADS-B?

A. Red ADS-B in line O of the GPD data block
B. Coral “A” adjacent to the track symbol
C. GPD data block will not display a projected route

Route Decisian Suppart Taol, Par 2

Lesgon 3 Inreduction o En

Question: How can you determine if a GPD track has no ADS-B?
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GRAPHIC PLAN DISPLAY (coNnT'D)

Knowledge
Check

Knowledge Check
What does 280 mean in this GPD data block?

/SAMOG1
A Spﬂﬁvld /2501229
B. Heading :jr:"l KSSC 216
C. Assigned altitude 28!3

Question: What does 280 mean in this GPD data block?
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GRAPHIC PLAN DISPLAY (coNnT'D)

Knowledge
Check

Knowledge Check

How can you determine if the GPD is displaying
future time?

A. Future time is displayed in the GPD header
B. EDST clock will indicate plus time in minutes

C. GPD target symbols look like an hourglass

Route Decisian Suppart Taol, Par 2

Lesgon 3 Inreduction o En

Question: How can you determine if the GPD is displaying future time?
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GRAPHIC PLAN DISPLAY (coNnT'D)

Knowledge
Check

Knowledge Check

What is the keyboard command to open the
GPD?

A. UU GPD
B. WU G

C. UU GP

Question: What is the keyboard command to open the GPD?
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GRAPHIC PLAN DISPLAY (coNnT'D)

Knowledge
Check

Knowledge Check

How would you access the menu to display or
remove SAA labels on the GPD?

A. TBP Tools>Airspace Status...
B. TBP Military...>Area Names...
C. TBP Map Options=Map Features

Route Decisian Suppart Taol, Par 2

Lesgon 3 Inreduction o En

Question: How would you access the menu to display or remove SAA labels
on the GPD?
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GRAPHIC PLAN DISPLAY (coNnT'D)

Knowledge
Check

Knowledge Check

How are TFM-protected routes depicted on the
GPD?

A. White chevrons bisecting the route
B. Cyan “T" adjacent to the GPD position symbol

C. Projected route segments are colored cyan

Route Decisian Suppart Taol, Par 2

Lesgon 3 Inreduction o En

Question: How are TFM-protected routes depicted on the GPD?
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FREE FORM TEXT

Record Data

JO 7110.65, par.
13-1-8,

TBL 13-1-1,
TBL 13-1-2,
TBL 13-1-3

Free Form Text

.| Posting Rode| | Temalate...

Taol, Part 2

® Control information not otherwise recorded via automation recordings or
voice recordings must be manually recorded using approved methods

©®

When an ACL or DL entry’s free text area is used to enter control
information, you may use:

Clearance abbreviations

Miscellaneous abbreviations

EDST equivalents for control information symbols

Plain language markings when it will aid in understanding information
Locally approved abbreviations

Continued on next page
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FREE FORM TEXT (coNT'D)

Record Data Example: D-A -TFD RV 50 %400 AF10 MIN*% V0040 %45% (C132.9
(Cont’d)
D-A Cleared to depart KCGA (Casa Grande Municipal Airport) to

#2—17-1810.65, par. CYKA (Kamloops)

TBL 13-1-1, -TFD Direct to TFD (Stanfield VORTAC)
TBL 13-1-2,

TBL 13-1-3 50 Climb and maintain 5,000’

%400 AF10 MIN* Expect FL400 after 10 minutes
Vo040 *453% Clearance void 0040, advise by 0045

C132.9 Contact frequency 132.9

®© Free text area must remain open and visible when it contains control
information

® When no longer relevant, the information entered into the free text area
must be updated or deleted

® Control information entered in the free text area must be used for
reference purposes only

® Information entered into the free text area is not forwarded and, if
necessary, must be coordinated
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FREE FORM TEXT (CONT'D)

Authorized
Abbreviations

JO 7110.65,
TBL 2-3-11,

TBL 2-3-12,

Figure 2-3-7,
TBL 13-1-1,
TBL 13-1-2,
TBL 13-1-3

ERAM ATCHI
MISC 230.05,
par. 6.8.1

FAA55054003-LP03 / V1.0 2022.08

Authorized Abbreviations

* Free Text Areas cannot accept all manual
strip marking symbols

] k] (1.
L35S 488 @/92 = KCGZ.

D-A -TFD 158 =488 AFle M

LYEAS 8221
[h* Vaadd =45* C132.9

918 LN3IS2HS

3

KCGZ CYKA/B221
LN14H 150 Ji
LJ35/L Ve@BUd (U5) -TFD D_A
@
| TN
KCGZ PEO3D g C 1323

® ACL and DL free text areas cannot accept all manual strip marking
symbols for control information, but instead use the following:
* Appendix A, Clearance Abbreviations
* Appendix B, Miscellaneous Abbreviations
* Appendix C, EDST Equivalents for Control Information Symbols

NOTE: Appendix D, compares select manual strip marking with approved
free text control instructions
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FREE FORM TEXT (CONT'D)

Knowledge
Check

Knowledge Check

When must the free text area be open and
visible?

A. Any time a flight is within your sector
B. When a flight is nonradar

C. Ifit contains control instructions

Route Decisian Suppart Taol, Par 2

qon 3 Introduction o En

Question: When must the free text area be open and visible?
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FREE FORM TEXT (CONT'D)

Knowledge
Check

Knowledge Check

When can plain language be used in the free
text area for control instructions?

A. Never
B. To aid in understanding information

C. When free text is automatically forwarded at handoff

Route Decisian Suppart Taol, Par 2

qon 3 Introduction o En

Question: When can plain language be used in the free text area for control
instructions?
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PART-TASK EXERCISE: EDST PART 2

Purpose

Materials

Directions

Part-Task Exercise
* Purpose
— Perform the following tasks:
» ldentify features of the Tools Menu
» Demonstrate Gl Message View and SIGMETS View features
# ldentify weather and altimeter displays
# Interact with the GPD
+ Materials
— TTL part-task exercise: EDST Part 2
* Directions

— This exercise takes approximately 45 minutes to complete.
Each student must complete the checklist tasks. No headsets
are required.

Perform the following tasks:

© Identify features of the Tools Menu

© Demonstrate Gl Message View and SIGMETS View features
© Identify weather and altimeter displays

® Interact with the GPD

=) Handout:

®© TTL part-task exercise: EDST Part 2

n TTL Scenario

This exercise takes approximately 45 minutes to complete. Each student
must complete the checklist tasks. No headsets are required.

FAA55054003-LP03 / V1.0 2022.08 Page 82



CONCLUSION

Lesson
Summary

Lesson Summary

This lesson covered:

* Features of the tools menu

+ Steps to interact with NOTAMs, Gls, and
SIGMETs views

* Weather and altimeter displays of EDST
« EDST free form text

ute Deci=ion Suppaoit Taol, Part 2

Features of the Tools Menu

Steps to interact with NOTAMSs, Gls, and SIGMETs Views

Options Menu

Airspace Status View

Airport Stream Filter Status Display
Restrictions View

Current Restrictions View

NOTAMS View - access

Gl Messages View - access

— Forwarding Gl messages

— Deleting single Gl message

— Deleting multiple Gl messages
SIGMETS View - access

Continued on next page
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CONCLUSION (conT'D)

Lesson * Printing - NOTAMs, Gl messages, and SIGMETs
Summary

(Cont’d) — Printing a single entry

— Printing multiple entries
— Printing all entries
®© Weather and altimeter displays

* Weather Station Report View
* Altimeter Settings View
*  Wind grid
— Layout and function
— Recenter
— Change range
— Change display altitude
— Problem indication
® Graphic Plan Display

* Access
* Layout
* Map symbols
* Aircraft Display Menu
*  Menu bar
— General
— Flight specific
— Plan specific
* Main display area and route symbols
* GPD data block
* Future Time bar
© EDST free form text
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APPENDIX A

Clearance Abbreviations

Abbreviation Meaning

A Cleared to airport (point of intended landing)
B Center clearance delivered
C ATC clears (when clearance relayed through non-ATC facility)

CAF Cleared as filed
D Cleared to depart from the fix
F Cleared to the fix
H Cleared to hold and instructions issued
N Clearance not delivered
O Cleared to the outer marker

PD Cleared to climb or descend at pilot's discretion
Q Cleared to fly specified sectors of a NAVAID defined in terms of courses,

bearings, radials, or quadrants within a designated radius

T Cleared through (for landing and takeoff through intermediate point)
Vv Cleared over the fix
X Cleared to cross (airway, route, radial) at (point)
Z Tower jurisdiction
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APPENDIX B

Miscellaneous Abbreviations

Abbreviation Meaning
BC Back course approach
CT Contact approach
FA Final approach
FMS Flight management system approach
GPS GPS approach
I Initial approach
ILS ILS approach
MA Missed approach
NDB Nondirectional radio beacon approach
OTP VFR conditions-on-top
PA Precision approach
PT Procedure turn
RA Resolution advisory (Pilot’s reported TCAS event)
RH Runway heading
RNAV Area navigation approach
RP Report immediately upon passing (fix/altitude)
RX Report crossing
SA Surveillance approach
Sl Straight-in approach
TA TACAN approach
TL Turn left
TR Turn right
VA Visual approach
VR VOR approach
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APPENDIX C

EDST Equivalents for Control Information Symbols

Abbreviation Meaning
T dir Depart (direction if specified)
1 Climb and maintain
! Descend and maintain
CR Cruise
AT At
X Cross
M Maintain
| airway Join or intercept (airway, jet route, track, or course)
= While in controlled airspace
WICA While in control area
dir ECA Enter control area
dir OOCA Out of control area
. Cleared to enter surface area. Indicated direction of flight by appropriate
dir ESA compass letter(s)
Through surface area and altitude indicated direction of flight by appropriate
TSA alt compass letter(s). Maintain special VFR conditions (altitude if appropriate)
while in surface area
250 K Aircraft requested to adjust speed to 250 knots
-20 K Aircraft requested to reduce speed 20 knots
+30 K Aircraft requested to increase speed 30 knots
SVFR Logal Special \(FR.operati.ons in the vigipity of (r]ame). airport are authorized
until (time). Maintain special VFR conditions (altitude if appropriate)
B4 Before
AF After or Past
/ Until
xinstructions* | Alternate instructions
REST Restriction
AOB At or Below
AOA At or Above
- From-to (route, time, etc.)
(AB(AI) Inc_licates a block altitude assignment. Altitudes are inclusive, and the first
altitude must be lower than the second (Example 310B370)
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Continued on next page
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APPENDIX C

EDST Equivalents for Control Information Symbols

Abbreviation

Meaning

V time Clearance void if aircraft not off ground by time
CL Pilot canceled flight plan
+info+ Information or revised information forwarded
kkaltk x Other than assigned altitude reported Example: %%50% %
ARC mi. dir. | DME arc of VORTAC or TACAN
Contact (facility) or (freq.), (time, fix, or altitude if appropriate). Insert frequency
C freq. only when it is other than standard
R Radar contact
R alt Requested altitude
R/ Radar service terminated
RX Radar Contact Lost
RV Radar vector
RVX Pilot resumed own navigation
HO Handoff completed
E Emergency
w Warning
P Point out initiated. Indicate the appropriate facility, sector, or position.
FUEL Minimum fuel
EFC time Expect further clearance at (time)
- fix Direct to fix
FRC Full route clearance
IAF Initial approach fix
NORDO No Radio
PT Procedure turn
RLS Release
REQ Request
Si Straight in
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APPENDIX D

Table compares select manual strip marking with EDST Equivalents for Control Information
Symbols.

Manual Strip EDST Free Meanin
Marking Text g
T T dir Depart
() *instrx Alternate Instructions
4 AF After
> B4 Before
V<(Time) V time Void after
q:_ CL Cancel IFR
—_ REST Restriction Bar
N AOA At or Above
NN AOB At or Below
D) ok altk* Other than assigned
. CR Cruise
® HO Radar Handoff Complete
X RX Radar Contact Lost
J 4 R/ Radar terminated
—7 | airway Join
mile ordion | ARC mi. dir. | DME Arc
C (Time/Fix/Altitude) C freq Contact Communications
@ AT At
—_— = While in controlled airspace
AN WICA While in control area
ﬂ dir ECA Enter control area
K dir OOCA | Out of control area
. Cleared to enter surface area. Indicated direction of flight by
W_@ dir ESA appropriate compass letter(s)
Through surface area and altitude indicated direction of flight
W—6> TSA alt by appropriate compass letter(s). Maintain special VFR
conditions (altitude if appropriate) while in surface area
Local Special VFR operations in the vicinity of (name) airport
@ SVFR are authorized until (time). Maintain special VFR conditions
(altitude if appropriate)
— From-to (route, time, etc.)
O +info+ Information or revised information forwarded
EFC time Expect further clearance at
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